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1 Introduction 

1.1 Overview (What is Apaix?) 

Apaix is a data visualization program working with many different sources. It comes together with a 
video player to allow synchronizing data and video. 

The current version of Apaix contains two different types of plots, a docking System to customize your 
layout, which can also be shared with other people. Also, there are multiple Layers of data that can 
import quite a lot of different data formats and is also able to export them or build virtual channels 
from them. 

The native format for Apaix are *.TKS files and will be also the type of the export. 

1.2 System Requirements 

- Windows 7/10 64 Bit 
- DirectX 9.0c or higher 
- Microsoft Visual C++ Redistributable 2013 
- Microsoft .Net Framework v4.6.1 

1.3 License Agreement 

 
  Except where otherwise noted, all of the data, documentation and software 

included in the APAIX Setup package is copyrighted by TeKshift GmbH. 

 

Copyright (C) 2012-2022 TeKshift GmbH. All rights reserved. 

 

This software (product from TeKshift GmbH) is provided under your 

license agreement with TeKshift GmbH. 

 

In no event shall the author be held liable for any damages arising from the 

use of this software. 

 

TeKshift GmbH 

Promenade. 7, 52076 Aachen, Germany 

Mobile: +49 152 06427936 

Email: info@tekshift.de 

http://www.tekshift.de 

http://www.tekshift.de/
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1.4 Installation 

Any older versions of Apaix should be uninstalled properly before installing a newer version. 

 

Step 1: 

Start the Setup.exe to start the installation. 

Step 2: 

 Select the language for the installer. 

(Apaix itself will remain English only) 

Step 3: 

 Follow the default steps of the installation and read the License agreement. 

Step 4: 

If you have a demo version, you need to copy your demo license file into the installation folder 
of Apaix. Otherwise, for users with a valid dongle, just make sure the dongle is inserted and 
start Apaix. 

 

Depending on the license type a USB-Stick containing the license will be needed to run. 

 

To uninstall Apaix, use the uninstall.exe in Apaix main directory. 

 

1.5 Known Problems / Limitations 

The following things about the current version of Apaix should to be taken into consideration: 

 - Signals can only be plotted once for each window. 

 - The concatenation of files is not working for now. 
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2 Quick Start 

1. Start Apaix. 
2. Double click the first layer label on the top left of the screen. 

 
3. Select the file type and load the file you want to load. 

 
4. Click on File -> New Window -> Plotwindow 

 
5. Drag the window to the middle symbol on the screen. 

   
 

6. Click the plot area and then press ‘P’ 
7. Select a signal you want to plot, and press submit. 
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3 Layers 

A layer is basically an individual container for the data you want to load. 

There are a total of 6 layers that can be switched on or off by selecting them in the DataLayer 
dropdown menu. 

 

Each Layer has its own color for overlaying different layers and if wanted, you can change the color in 
the options window. 

On default the first Layer is always activated, and it is necessary to have at least one layer activated to 
be able to see some information. 

Also, Layers shown on the main page can be de/activated by right clicking the text of those labels. 

If you want to clear a Layer, just go into the “Clear” menu item and select the Layer you want to clear. 

 

Cleared Layers will directly be deactivated. Also loading a file into a Layer will automatically activate 
it. 
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4 Data 

4.1 Loading 

Click on the “File” dropdown and hover above “Load File” to see a selection of all layers available.  

 

Click on one of those Layers to load a file into this this layer. Alternatively, you can double click one of 
the Layer labels and you will directly get to the load dialog.  

Note: The last folder location you load your data from, as well as the file type, will be memorized and 
stored into your layout. And loading into a deactivated Layer will activate it automatically. 

 

If loaded successfully, the file will be displayed directly in the layer information bar. 

 

4.2 Import data from other tools 

To import nonnative Apaix files you will need to set the filter in the loading dialog. On default it is set 
to *.TKS files. 

  

The supported types you can load are: 

• Mat-Files (*.tks,*.mat, *.h5) 

• Ascii (*.txt) 

• Wintax (*.prn) 

• Motec (*.csv) 

• DSpace (*.csv) 

• TDMS (*.tdms) 

• Session Info (*.apxs) 
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Ascii, Wintax and Motec are a bit different to import than the rest. That is, because they are saved in 
text format and the files must be parsed. So, a file converter will pop up. 

The window below is the parser that puts the lines of the *.txt file to data: 

 

Let’s zoom on it: 

 

• Name Line: The line in which the signals names are listed. 

• Value first Line: The line in which the first values are listed 

• Value last Line: The last value that will be imported from the file.  
(INF reads to the end of the file) 
 

Set the matching delimiter and the file converter will parse it into the preview window.  

If everything is alright, it should look like the parsed values in the screenshot. 

If something is wrong, like if you have less signals than data vectors or no present time vector, it will 
render the ok button red and it won’t accept the file. 

So, make sure the first entry of the signals names is always “Time”. 

4.3 Quick Loading 

Double click one of the Layer Labels and the loading dialog will directly pop up. The selected file will 
be loaded into the clicked layer.  

4.4 Multi-rate data 

Apaix can handle different rates, as every Signal gets its own Timevector. Depending on the import 
type. 
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4.5 File-Concatenation 

Concatenating files is currently not working.  

4.6 Export 

Exports will currently always create a *.tks file, which can also be opened with Matlab. The file will 

contain a unified Timevector created by the user defined logging rate and the time range of what 

should be exported. 

To export a file, just go to the File dropdown and select the layer which you want to export inside the 

Export dropdown.  
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The following dialog will then appear: 

 

• The Signals that shall get exported are predefined as the Signals plotted in the active 

Plotwindow and can be altered if wanted (only available signals will be there) 

• The boxes underneath the Signals are text-filters  

• The “All” button will put all Signals to the Export 

• The slider sets the range of the Timevector of the Signals to be exported 

• The left box under the slider is for the starting time of the Timevector and the right box for 

the end time, while the “Complete” button sets both values to the maximum 

• The box underneath the “Complete” button is for the logging rate to decide how big the steps 

should be and is entered in seconds 

• On the right of it, there is the “Start at 0” box which lets the export begin at a zero-based time 

• Then there is the progress bar that indicates the progress of the export. 

• Even virtual channels can be exported as real signals this way, they appear at the bottom of 

the signal List in green as usual, but only if they can be used 
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5 Enumerations 

5.1 Creating Enumerations 

 First go to the Enumeration Manager, which will open if you click on “File” then “Enumerations”. 

 

 

The resulting window will look like this: 

 

1. Double Click into the first empty field of the Enumerations 
2. Enter a name 

 
3. Double Click into the filed Value, Display, Description to enter their values. 
4. If the last wanted field is Edited, hit “Enter” and the field will be added to the List. 
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Note that there is always an empty Line at the bottom if it is a table where you can create new items. 
Also, there is some error check, which will render the fields red, if something is wrong, 

Like multiple occurrences of the same Enumeration - Name or Value in the Enumerations Value – 
Column. 

 

 

You can delete them by selecting the column that should get deleted and press the delete key “Del” 

5.2 Using Enumerations 

Now that the Enumerations are created, they will need to be assigned to signals to be used.  

So, go to the Attribution page of the Enumerations Manager: 

(In this example we have an Enumeration called Gears) 

 

 

• If an Enumeration is selected, the Selected Signals List will display which signals are selected 
for the Enumeration. The “Signals from Source” List will show all currently available Signals 
and Virtual Channels. 

• Removing is again the “Del” Key 

• Not Existing signals can be entered by double clicking the empty cell in the “Selected Signals” 
List and confirm with “Enter”  

• Already Existing ones can be entered by double clicking a signal from the list. (For example, 
Gear) 

• Also, you can filter with the filter fields on the bottom. 
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Now that the signals have been assigned to the Enumeration “Gears”, both will display the 
corresponding Values that have been entered in the Enumeration, should the value be found. 
Otherwise the displayed value will be “NaN”. 

 

 

5.3 Import & Export 

First of all, exporting will only work for the file type “*.enum” and will export as text in an xml 
structure. 

So, to export, just click the “Export” button and select a destination. 

 

For importing there will be box that can appear if duplicates were found before merging your actual 
list and the Enumerations found in the file. 

 

• Replace: The Enumeration will get its values replaced by the ones found in the file 

• Create New: The Enumeration will be given an extension with “_NUMBER” which is 
incrementing, if the actual number is found already and be added to the list. 

• Ignore: The found duplicate will just be left out of the import. 
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6 Plotwindows 

Currently there are two different types of plots and a data visualization and a CAN-Reception window. 
The normal X-Y-Axis plot and a Scatterplot where different signals can be plotted and the visualization 
window that can hold signals and just display their values like the legend in the other windows. Also, 
there is the Signal Explorer, which is a tool to plot signals easily. 

These windows can be docked like the user wants to freely customize the layout over several pages 
and save it for later use. Also, the save structure of Apaix allows for an easy option to share whole 
layouts or just single pages you created with someone. 

6.1 Creation and docking  

The File dropdown contains in the “New Window -> Plot Window” option.  

 

 

The Plot Window will be created in the upper left area of the screen. 
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After creation you need to dock it in your working area. Just drag and drop the window where you 
want to have it  

 

• Middle: insert as a main document 

• Sides: insert a window as a side document 

Drop the Plotwindow on the symbol in the middle to make it automatically take all the space. 

Drop on the sides will fix it to that side, with not taking all the space.  
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If there are already Plotwindows present: 

 

• Middle: put it into the existing plot window. (It will get a second tab) 

• Halved: divide the available space, so that each window gets the same size 

• Edge: puts the Plotwindow far to the relative edge, taking a minimum of space. 
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6.2 Using the Plotwindow 

This step assumes Data loaded and windows in place. 

❖ Plot data in the window   

Right clicking the legend on the right side of the plot will open a context menu displaying three 
options. Select signals, Show and Background. 

Select Signals opens the signal selection window. 

 

❖ Add a signal in the list 

Clicking once on an available signal is enough to add it in the list for signals in plot. The line with 
the cursor focus is a filter used for full text search in your signals list. Also, the filter is capable to 
use wildcards like “*” or “?”. 

• “*”: Star counts for 0 or any number of any character 

• “?”: Question mark is used for just one random character 

❖ Remove a signal from the plot  

Either double left Click on the “Signals in Plot” section or select them and press delete on your 
keyboard to remove them.    
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Plotting a signal would look like this: 

 

 The value is for the current cursor position. (Solid red line)  

❖ Cursor tool  

The cursor is the dashed red line in the plot and can be moved by either clicking/dragging 

somewhere in the plot with the left mouse button or using shift plus the left or right arrow keys. 

To activate an auto scroll like function, like in documents, just use either s, or press the left mouse 

button and while pressing click the right mouse button once and release the left mouse button. 

Then just move the mouse to the right or the left, to scroll into that direction. If the cursor gets 

moved, the scatterplot will also show which point is currently relevant. 

❖ Zooming 

Normal zoom:  

You can zoom in/out with either the mouse wheel, or the plus/minus buttons, or the page 

up/down buttons on the keyboard.   

Default X or Y- direction:  

Use the middle mouse to drag an area that will be zoomed in or use ctrl and right click to do the 

same. If done normally the zoom will take the x-direction. However, if you hover with the mouse 

over a Y-axis it will apply the zoom for the said Y-axis. 

Axis reset:  

Press A to reset the x axis or press shift and A to reset x and y axes for the selected Plotwindow.  
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Set distribution:  

If you have moved your Y-Axis manually like you want and it should always stay like this on 

resetting the axes, press the “right mouse button” while hovering with the mouse over the certain 

y-axis. 

The Signals will then automatically set their distribution value. 

Zoom Box:  

You can enter it by pressing “Z”, “X” or “Y” while the plot is being focused and you can switch 
between the modes by just pushing the other buttons. If you are in any mode and press the same 
key again you will end the Zoom Box Mode. 

When using the zoom mode, it will replace the panning function of the right mouse button in the 
plot by instead creating a zoom box, depending on the mode. If the right mouse button will be 
released, the plot will apply the zoom. And the mode is depicted on top of the plot. 

 

Zoom in 

 

Zooming in will always take the area that is being selected, depending on the mode. To zoom in 
you must move the mouse to the right, compared to where the initial click happened, regardless 
if x, y or xy-mode. 

  



 

By TeKshift GmbH, Promenade 7, 52076 Aachen  
 

Apaix 
 

                                         User Guide  22/49 

 

Zoom out 

 

Zooming out will always zoom out by a set margin and will only zoom out the direction that reflects 
the current mode. To zoom out, do the opposite than to zoom in. Move the mouse to the left, 
relative to the initial right click. Also, if executed properly, there should be the X appearing inside 
of the area. 

❖ Move the axis 

Axes can also be moved with drag and drop with the left mouse button. This applies to both, x and 

y axes. 
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❖ Parameter Window 

Double click in the legend area to open the signals parameter page.  

The parameter page is divided into the Signals and the Segments Page. 

Signals: 

 

 

The formula for the first order filter is: 

 

 𝒚𝒌 = 𝒚𝒌−𝟏 + (𝟏 − 𝒆−𝟐𝜋𝑓𝒕) .  (𝒙𝒌 − 𝒚𝒌−𝟏) 

 

The sample time period will be automatically detected in the software. 

A left click on the parallel modes column header will align everything to fit into parallel mode.  

Switching the Auto-Distribution off, allows to set the absolute min and max of the axis range, 
which prevents zooming out going too far.  

❖ Segments 

        

 

Segments are a new introduced feature that allows to have a clear division in the same graph. 
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By adding a segment, it will automatically be added with a segment height of 1. The percentual 
usage of the screen of the segment will change for both to 50 % because now there is 2 segments 
with each having a height of 1.  

 

 

The segment height divisor depicts the total height of all segments together, which means if there 
are 5 segments with a height of 1 the divisor will be 5. And each segment takes 20 % of the screens 
space. 

 

 

Example of 2 segments with the same height: 

 

Note that a new Signal will always on default end up in segment 1, so you have to manually set 
them in the Signals Property Page. 

❖ Min, max, delta & average  

Right click the legend to open the context menu, then select min, max, delta or average of the 
signals, which get automatically calculated depending on the focused area, to show them.  
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❖ Gradient cursor 

Select signals in the legend and press the “G” key to toggle it. The gradient cursor can be dragged 
if you click in its middle. If you pick the outer parts you will move the tips of it. 

 

The plot can have one gradient cursor per signal and have them all active at the same time.    

❖ Reference Cursor 

Pressing “R” will activate it at the position where the cursor was at the last time and it will create 
an area between itself and the normal cursor. The area affects:  

• Min, Max, Delta, Average (calculated only in this area if active) 

• Scatterplot renders points outside of this area transparent to show selected data, if active 
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❖ Set Legend Width 

To change the legends width just move the line between plot and legend per mouse drag. But for the 
normal plotwindows there is an automatic alignment for the legend to autofit the information 
displayed. This does however not apply if the Plot width is being synched with other plots. 

 

❖ Synch Plot Width 

Synching the width of the plot is done by right clicking the windows title and selecting “Link Plot-
width”. 

 

The Link will keep the width of the legend, as well as the space the visible y-axes take linked 

between all currently visible Plotwindows. So, if an axis gets added, the space will be adjusted. 

 

Note: This functionality is not available for Scatterplots. 
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❖ Hiding the X-Axis 

If the X-Axis takes too much space or like in the above example for linked windows is disturbing to 
have multiple times, press “Shift” and “X” simultaneously to toggle the visibility of the X-Axis. 

 

 

Here you can see the difference in height if the X-Axis is set to be invisible. 

 

You can also Rightclick the Axis, even when hidden, to open a small context menu that has the 
possibility to hide, or unhide the X-Axis. 

 

Note: This functionality is also Plotwindow only. 

 

❖ Reset Line Color 

This function will apply the default colors (depending on the background color) from top to bottom of 
your legend area. Can be used to make a window printable, by setting the background to white and 
then reset the lines colours to fit the white background. 
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7 Layouts 

Click “Save Layout” in the “File” dropdown. 

 

7.1 Saving with custom name 

Type the layout name and press save. It will save your layout and close the layout save window.  

7.2 Overwrite, rename and delete 

If the layout is already present, just double click in the list to save it. To rename or delete, select a 
layout in the list clicking once and click on either “Delete”, or type the new name and press 
“Rename”. 

7.3 Load a Layout 

Select the Load Layout option in the File dropdown and double click the wanted layout.  

You can also set the check in the options menu to always load the last used layout on startup. 

7.4 What happens on saving? 

If the folder is not present, Apaix will create a “Layouts” folder inside its main directory and put a 
folder inside that labels the name of the layout. Inside pages and one workbook are stored. For 
sharing either share the whole folder or give single pages that will be put into a new layout folder. 

Note: Pages can be created/deleted/renamed by right clicking on the page in the lower left area 
of the screen. However, the last one remaining can’t be removed. Also the Workbook contains 
Enums, Virtual Channels and the information about last used data types and paths. 
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8 Scatterplot 

It will be created and docked just like the normal Plotwindows. It can only show one combination of 
signals at the same time, but for each layer that is active. The first layer as shown in the picture uses 
this blue color, as for the other layers, they use their own color. 

 

❖ Uses the Layers main color to display values 
❖ Display is linked to Plotwindows range and will automatically alter the displayed data depending 

on the relevant area. 
❖ The legends context menu has a setting to always use the full range, if the reduction is not wanted. 
❖ The reference cursor link will change the relevant range to the selected area, rendering points 

outside of the selected area a bit more transparent. 
❖ Tracker that allows to read each point’s exact data by just holding down the left mouse button on 

a designated point. 
❖ Settings in the legend’s dropdown menu allows to use always the full range of values if preferred. 
❖ Tracker will automatically display the selected point, when the cursor of Plotwindows is moved. 
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9 Options 

The Options window can be reached by clicking the gear symbol in the menu bar. 

 

This Menu contains Three categories: 

• General 

• Graphical Settings 

• Player 

9.1 General 

 

General contains the default browser path for Data to load, if the last data path from the layout is not 
available. 

The the import and export functions for the settings. 

And the option to open the last used Layout.  

The files exported will be *.cfg files and loading them will apply to all the options in the General and 
Graphical Settings tabs.  

The Player Tab will be referenced in the video player related section of this guide. 
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9.2 Graphical Settings 

 

The Graphical Settings are divided into several parts as well: 

• Layer Settings 

• Plotwindow Settings 

• Default Grid 

• Scatterplot Settings 

• CAN Reception Settings 

❖ Layer Settings 

Here you can select individual colors or line pattern for each layer and define if the layers should 
keep their color when using multiple Layers at the same time. 
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❖ Plotwindow Settings 

Here you can define if you want to see the points of the series, activate the point tracking which 
will draw a little X where the cursor hits the series line, activate showing the y-axis of selected 
signals or set the Custom Y-Grids Visibility. The latter will display a grid corresponding to each 
visible y-axis. Also, you can decide on the default Warning Line Pattern, the Series Type and the 
Highlighting. 

The Highlighting lets you choose from a normal highlight, blinking and pulsing. The Brightness min. 
defines the transparency applied to the selected signals. If blinking with a brightness min of 0, 
then the signal will completely disappear and reappear shortly after that. However, if it is at like 
150, it will swap between less visible and fully visible. And finally, with pulse it will gradually fade 
until it reaches the minimum and then gradually get more visibility until fully visible again. 

❖ Default Grid 

You can adjust the visibility of the default x and y axes grid visibility and also pick a color and a 
pattern for them. 

❖ Scatterplot Settings 

You can define weather you want to have the dots connected by a line on default. 

❖ CAN Reception Settings 

This sets the Refreshinterval for the UI of the CAN Reception controls. 
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10 Video Player 

10.1 Starting the player  

To open, click the small player symbol in menu bar, but remember that it is important to have the 
correct layer selected. 

 

The right layers would be layer 1 and layer 2. Layer 1 is hereby always needed, because layer one 
points to the video one of player 1 and video 2 points to player 2. 

That means  Layer 1 = video 1 = player 1 

              Layer 2 = video 2 = player 2 

So left click the Layer you wish to select when loading a video. (Before loading a video in layer 2, layer 
1 must have a video present) 

 

*note that the symbols to control the player appear after the player is visible. 

Click the blue folder button to open a video file for the player, depending on the layer you selected. 
The play, stop, pause and frame by frame buttons count for both players simultaneously. 

10.2 Settings and synchronizing 

To synchronize the video with the data, the video to data offset needs to be set for the depending 
layer. After pressing “Shift” + “O” in the Plotwindow and the video to data offset can be changed like 
the normal offset. While doing this the cursor can be moved to see the point in the video, then move 
the axis to select a part where video and data look matching. Then just press “O” again and it will be 
set.   

If known the numerical value for the offset can be entered manually in the Offset tab next to the data 
layers. 

 

The gauges are a visualization of signal data. They can be set in the options menu in the tab Player and 
then Signals. The User has to select signals that fit the display. 

On the second tab in the Player settings there are max engine speed, limiter speed etc. 

Some can be set for both players and others are for each individual player. 
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10.3 Gauge Explanation 

1. RPM = the Curved line that starts yellow and 
turns into red the further it reaches the limit 

2. Lateral and Longitudinal Acceleration = the 
box in the top right in the picture 

3. G – Sensor = The part in the very middle 
calculated by Lateral and Longitudinal 
Acceleration 

4. Gear and LED = the box with the value 2 is the 
gear and the LED is the one right next to it 

5. Speed = the box with the 102 kph 
6. Throttle = the box with 0% 
7. Brake = the box with 51.0 bar 

 

10.4 Session Info 

The Session Info is a file that gets created when loading a new data-file, as long as it does not already 
exist. 

It is named after the file, but with a different ending. It is:  *.apxs  

It stores information on the Video to Data Offset and the signals that were to be displayed for the file. 

To save those settings into the *.apxs-file you will need to check the box corresponding to the layer 
and save to overwrite the previous/default settings. If you don’t check the checkbox you can still have 
a look at your signals without saving them into the Session Info. 
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To save the Layout just go to your Offsets and click the last option.  

If you reset the Video to Data-Offset, it will be reset to the value saved in the Session Info for the 

selected layer. 

10.5 Fluid Videos 

In order to get the optimal speed when skipping through the video, there can be done two 
things to improve a slow video.  

1. Reduce the resolution of the video 
2. Reduce the range of I-Frames of the video 

This can be done with any video converting software, but we focus on the free tool Handbrake 
for now.  

 
The picture above shows a really good setup for videos, if the quality is not too important. 
 

• Reducing the Resolution will make the video faster and smaller.  

• Reducing the range of the I-Frames will make the video faster as well, but the size will 
be increased. 
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11 Signal Explorer 

In the menu “File” there is in “New Window” also the option to open the “Signal Explorer” window. 

This window allows the user to easily plot signals just by drag and drop. 

 

The Signal Explorer will have all signals that are available with data listed in the “Signals” tab and all 

virtual channels in the “Channels” tab. Also, the Explorer has a filter at the very bottom to alleviate 

the work of finding the signals in huge files. 

 

1. Load data 

2. Open the Signal Explorer 

3. Drag and drop the Signal into the desired Plotwindow or Scatterplot axis 

Also, if the little pin symbol with the tooltip “Auto Hide” is clicked when docked, the window will 

hide itself and be a little box at the border of the window. If you click it, it will enlarge and be 

normally usable and on focus loss it will go back to the hidden state. 

Note: Remember to always dock Floating windows, as it can make problems with loading and saving 

layouts.   
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12 Virtual Channels 

Virtual channels in Apaix are a way to create Signals that are processed with custom math formulas 

to apply any calculation that is wanted by the user. 

To access them just click on the green Square root symbol in the menu bar. 

 

And the resulting window will look like this: 

 

1. Add a channel 

2. Select the channel and then click the sources you want to have in the Signals Box on the left 

3. Enter the formula  

4. Use it in plots or the video player or even export it into a new data file. 

• Export / import channels or removing them from the list is also possible. 
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12.1  Adding / Removing a Channel 

 
When adding a new Channel it will appear with 2 indication triangles, a yellow and a red one. 
 

 
• Yellow: One or more Layers have no sources available 

• Red: The formula for this Channel is wrong 
 
Also note that the Name is given automatically and can be changed in the “Name” field after selecting 
the desired channel. Also, if the “NewChannel” is already present, the next channels will have an 
increasing number. If there is no “NewChannel” but a “NewChannel1” the tool will create the next 
channel with the name “NewChannel2” so the channel can always be found looking for the biggest 
number. 
 
When removing only select the desired channel and click the remove button. 
 

12.2  Selecting and removing Sources 

At first you select the channel and then click the desired sources in the Signals List. 
They will then be filled in as sources. 

 
• The “X” is the button to remove not wanted sources. 

• The Name is in a Textbox that allows renaming for more flexibility in terms of name convention 
changes 

• And the last Button is the variable name of the source (important for the formula). Clicking it 
will insert the variable into the formula at its cursor position. 

Note: Removing sources in between will cause the variables of the later ones to change its number. 
This means removing the “v3” will cause “v4” to become “v3” and “v5” will become “v4”.  
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12.3 Formula and Preview 

For this example, we take just two speed values and create an average 
 

 
 

• The “v1”, “v2” …. “vn” represent the sources covered in the last topic and clicking the button 
of the source will automatically place the variable at the cursor position of the formula box 

•  “v1” is basically the actual value for the first source for each value iteration as well as “v2” is 
the same for the second source 

• Brackets and mathematical operators can be used like in any formula, like here where the 2 
values get added and then divided by 2 

• The Preview writes the variables names out, so it is easier to have a good overview on the real 
names 

 

❖ Indexing 

The indexing allows to reach different values of the source than the actual one.  

• “v1( number )” will give out the value of the sources array at the position of “number”. So, 
this means “v1(0) will always give out the very first value of the source 

• “i1” stands for the actual index. Which means if you only put “i1” in a formula, the result will 
be a count from 0 up to the sources length – 1 

• “i1( number )” will give the actual index, but shifted by the “number” this means “i1(-1)” would 
be the previous index 

• “v1( i1(-1) )” Would then be the previous value of the first source the brackets after i1 can 
even be omitted and written as v1(i1-1) which is a bit shorter 

Also, the actual Timevector can be indexed as well. 

• “t1” which is basically the same as “t1(i1)” so the Time of the first source at the current index. 

• “t1(number)” which is the time of the first source at the chosen index 

The number that represents the source can also be put to 0, this stands for the channels output. 

• “v0” would then be the actual output value 

• “t0” is the actual time of the outputted channel 

• “i0” will then be the actual index of it 

Note: keep in mind that as the output signal is not already calculated there will be only NaN values 

which will require “if-statements” to be used along with these indexes. For “if-statements” read the 

next chapter.  
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❖ “If” statements 

In some cases, it might be needed to have some logic for formulas for example to have some kind of 
error detection. Here in this example we have set a range from -1 to 1 where the signal would be ok, 
in any other cases we will give out the value [NaN]. This will then be easy to note in the graph if there 
are breaks in the line. 

 

• The structure looks like this “if( condition, if  true, if false)” , so if the condition is true the 

part after the first comma will be the output and else the last part will be the output 

• Like here “v1>1” checks if the actual value is bigger than 1 “||” is the logical “or” and         

“v1 < -1” checks if the actual value is smaller than -1. If not, it will put out the actual value of 

the first source “v1” and otherwise the formula will put out a [NaN] value. 

• The preview will have the name of the Channel for the output. 

12.4 Import / Export 

The export is depending on which channels are selected.  Only the selected channels get exported for 
cases, where only a certain set of channels should be exported. 

1. Select all the channels that should get exported (“CTRL + Click” or “Shift + Click” are needed 
for the selection) 

2. Click the export button 
3. Save the file 

 

When importing keep in mind that only channels with different names than the actual existing 
channels get imported, to avoid losing your channels if the file has already channels that have the 
same name. 

The channels are saved as XML and can be altered with default text editors in cases they should be 
altered in any way before importing. 
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12.5 Integrate / Derivate 

To integrate we will use an if statement to exclude the very first value and set it to 0 and also be sure 
that the parser will not try to access the value before the first one, as this would lead to everything 
being NaN values because the first value does not exist already. 

 
Formula to copy and paste: if( i0>0, v0(i0-1) + v1*( t1(i1)-t1(i1-1) ),0)  

The part of “( t1(i1)-t1(i1-1)” here is the difference between the actual and the last time value.  If 

you do not want to have it starting with 0 , you can always set the first value of the source or 

anything else as the starting value, like “v1(0)”. 

 

To derivate we use basically the same things except we do not need the if statement. 

 

Formula to copy and paste: (v1 -v1(i1-1))/(t1(i1)-t1(i1-1)) 

“v1 – v1(i1-1)” is the difference between the actual and the previous value and this will be divided by 

“( t1(i1)-t1(i1-1)” which is the time difference between both values. 
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13 Live Data(WIP) 

For loading Live Data go to: 

 

Then you will be able to select the Protocol and the Layer you want to read into: 

 

Currently Apaix is only supporting CAN data as protocols. 

The supported Hardwares are : 

• PEAK 

• KVASER (WIP) 

Note that this feature is currently work in progress and also not available in the Demo Mode. 
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The CAN can be connected directly and DBC Files can be added later on. 

 

A list of several DBCs can be added to the layer and with “Apply” it will be set. 

13.1 CAN Reception Window 

 

Select the Layer in the top left Corner and the Reception Window will update the read messages in 

the rate put in the Options.  

Sending can be done with either the Cycle Time, or selecting the Message and send it Via the Send 

Button individually. 
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14 Demo Mode 

1.1 What is Demo Mode? 

It allows Apaix to be used without a license. However, it has some restrictions on features that can 
not be used. 

 

1.2 When is Demo Mode active? 

Demo Mode is running, if Apaix does not find a valid license on startup. If you want do have for 
example, a license dongle and start Apaix without plugging it in, you will need to restart Apaix and 
plug it in, in order to start Apaix in Licensed Mode. 

 

1.3 What restrictions are there? 

The Demo Mode restricts Loading, Saving, Renaming and Deleting of Layouts. Other than that, also 
the functionality to use Live CAN Data is restricted. Every other feature can freely be used. 
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15 Glossary 

❖ A: 

Auto-scroll mode: Depending where the mouse is relative to the cursor position, the cursor will 
scroll to the left or right. With increasing distance the scrolling will be faster. To cancel it, just press 
the |right mouse| or again |S| on the keyboard. 

❖ D: 

Default Background color: This setting will change the initial background color of the Plotwindows 
that get created to the corresponding color. If desired, the Plotwindows current background color 
can be changed in the context menu of the legend. 

❖ L: 

Layer: Apaix has a total of 6 layers. That means it can have up to 6 sets of data loaded 
simultaneously. The Layers are directly depicted on the main screen and they show which file is 
stored into them. They also show if they are active or not by being strikethrough if not active. 

Layer to Layer offset: This is the offset that can be set between the layers. It has no impact on the 
video synchronization. 

❖ F: 

Focus: Apaix has multiple windows and controls. Clicking on those will also give the focus to the 
designated element. For example clicking the plot will give the focus to the plot of that 
Plotwindow. 

❖ S: 

Signal: Basically rather a set of all possible signals for its name, depending on the amount of active 
layers. A signal contains everything that is needed to visualize it along with data up to 6 different 
datasets. 

❖ T: 

Twin video mode: The twin video mode is used to compare two sets of data, which have videos, 
with each other. It will be activated if Layers 1 and 2 are both active, video 1 has already been 
assigned to layer 1 and video 2 gets assigned to layer 2. 

❖ V: 

Video to data Offset: This offset is mainly used for the video synchronization but has currently 
also an effect on the offset between the layers. The way to use it would be to first align the videos 
with this offset and then if the layers are in synch with their corresponding videos, use the layer 
to layer offset to align the data, if more than one set of data will be used. This is subject to change 
in the future to not have an impact on the normal offset anymore. 
Start the change of this offset by pressing “Shift” + “O” inside of a Plotwindow and drag the Plot 
with the “Right Mouse Button”. If the offset looks good, apply it by again pressing “O”. 
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16 Key-bindings 

These bindings depend sometimes on which UI-element has the focus. As an example, in a Plotwindow 
you have the legend on the right side, and the plot on the left. If the binding is now only for the use 
inside the plot, you must click the plot before using the binding. 

16.1 Selection 

Select the nearest Signal to mouse position “Shift” + “Left Mouse Button” 

Select from Legend “Up” or “Down” 

➢ Use “Shift” or ”Ctrl” as modifiers for multi      
selection 

16.2 Signal alteration 

These commands work when the Plotwindow has the focus and signals are selected. 

Gradient Cursor “G”  

Hide Signal “H” 

Reference Cursor “R” 

Show Y-Axis “Shift” + “Y” 

Remove Signal “Del” 

Warning Lines “W” 

16.3 Additional Menus: 

Legend context menu “Right Click” in the legend 

Plot context menu “Right Click” the plots name 

Warning line context menu “Shift” “Right Click” while the mouse is over a 
warning line 

Axis context menu “Right Click” while the mouse is over an Axis 
(plotwindow only) 

Signal Selection Menu • “P” 

• open the context Menu and select it there 

Parameter Page “Double Click” in the legends area 
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16.4 Plot Movement 

Auto scrolling • “s”  

• Hold “Left Mouse Button” down, then “Right 
Click” and release the buttons 

Move axes • X-axis: “Left” or “Right” 

• All Y-axes: “Up” or “Down” 
➢ “Control” as modifier to do smaller steps 

Pan X Axis  hold “Mouse Right” in the plot and move the mouse 

Jump to Min / Max Activate min or max in the context menu 
and click the value of the signals min or max 

16.5 Zooming 

Normal Zoom Works either on the plot itself or any axis 

• “Mouse Wheel” 

• “Plus” or “Minus” 

• “Page Up” or “Page Down” 
➢ “Control” as modifier to do smaller steps 

for keys 

Select a Range to be zoomed 

• “Middle Mouse” 

• “Alt” +  hold “Right Mouse ” 

Zoom XY-Mode If the plot has the focus: 

“Z”: Changes the right mouse button to create a 
Zoom Box. Switched off if pushed again 

Zoom X-Mode 

 

If the plot has the focus: 

“X”: Changes the right mouse button to zoom the X-
Axis. Switched off if pushed again. 

Zoom Y-Mode If the plot has the focus: 

“Y”: Changes the right mouse button to zoom the Y-
Axes. Switched off if pushed again. 

Zoom out If in any of the above three modes, dragging the 
rectangle from right to left will let the user zoom out. 

Autozoom Y-Axis “F”: Changes the scale of the axes automatically, 
depending on the visible graph. 

Reset Axes 

 

• Only X:  “A” 

• All:  “Shift” + “A” 
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16.6 Misc.: 

Copy plot to clipboard “C” when the plot is focused 

Save Layout “Ctrl” + “S” 

Open Help “F1” 

Offset Mode “O” 

Video to Data Offset Mode “Shift” + “O” 

Set the Cursor position “Left Mouse Button” while in the plot 

Show/hide X-Axis “Shift” + “X” 
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